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C H A P T E R 3

Getting Started with CMS

This chapter describes the Cluster Management Suite (CMS) software:

• Features, page 3-2

• Front Panel View, page 3-3

• Topology View, page 3-9

• Menus and Toolbar, page 3-13

• Interaction Modes, page 3-22

• Wizards, page 3-22

• Online Help, page 3-23

• CMS Window Components, page 3-24

• Accessing CMS, page 3-26

• Verifying Your Changes, page 3-27

• Saving Your Changes, page 3-27

• Using Different Versions of Web-Based Switch Management Software, page 3-28

• Where to Go Next, page 3-28

Note For system requirements and for browser and Java plug-in configurations, refer to the release notes. 
For field-level descriptions of the CMS windows and for procedures for using CMS, refer to the 
online help.

Note This chapter describes the CMS interface used on the Catalyst 3550 switches. Refer to the 
appropriate switch documentation for descriptions of the web-based management software used on 
other Catalyst desktop switches, such as the Catalyst 2950, Catalyst 3500 XL, Catalyst 2900 XL, 
Catalyst 1900, and Catalyst 2820 switches.
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Features
Features
CMS provides these features (Figure 3-1) for managing switch clusters and individual switches from 
Web browsers such as Netscape Communicator or Microsoft Internet Explorer:

• Two views of your network that can be displayed at the same time:

– The Front Panel view displays the front-panel image of a specific switch or the front-panel 
images of all switches in a cluster. From this view, you can select multiple ports or multiple 
switches and configure them with the same settings.

When CMS is launched from a command switch, the Front Panel view displays the front-panel 
images of all switches in the cluster. When CMS is launched from a noncommand switch, the 
Front Panel view displays only the front panel of the specific switch.

Note CMS from a noncommand switch is referred to as Device Manager (also referred to as Switch 
Manager). Device Manager is for configuring an individual switch. When you select Device 
Manager for a specific switch in the cluster, you launch a separate CMS session. The Device 
Manager interface can vary between the Catalyst switch platforms.

– The Topology view displays a network map that uses icons that represent switch clusters, cluster 
members, cluster candidates, edge devices, and link types. From this view, you can select 
multiple switches and configure them to run with the same settings. You can also display link 
information in the form of link reports and link graphs.

This view is available only when CMS is launched from a command switch.

• Menus and toolbar to access configuration and management options:

– The menu bar provides the complete list of options for managing a single switch and switch 
clusters.

– The toolbar provides buttons for commonly used, switch- and cluster-level configuration 
options, and information windows such as legends and online help.

– The port-level pop-up menu, in the Front Panel view, provides options specific for configuring 
and monitoring switch ports.

– The device-level pop-up menu, in either Front Panel or Topology view, provides switch- and 
cluster-level configuration and monitoring options.

– The candidate, member, and link pop-up menus provide options for configuring and monitoring 
devices and links in the Topology view.

The toolbar and pop-up menus provide quick ways to access frequently used menu bar options.

• Tools to simplify configuration tasks:

– Interactive modes—guide mode and expert mode—that control the presentation of some 
complex configuration options

– Wizards that require minimal information from you for QoS and IP multicast configuration

– Comprehensive online help that provides high-level concepts, field-level descriptions of the 
window, and procedures for performing tasks from the window

• Consistent set of GUI components (such as tabs, buttons, drop-down lists, tables, and so on) for a 
consistent approach to setting configuration parameters
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Front Panel View
Figure 3-1 CMS Features

Front Panel View
The Front Panel view is the best tool for configuring and monitoring a switch or the switches in a cluster. 
When CMS is launched from a noncommand switch, the Front Panel view displays only the front panel 
of the specific switch (Figure 3-2). When CMS is launched from a command switch, the Front Panel 
view displays the front-panel images of all switches in the cluster (Figure 3-3). 
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Front Panel View
Figure 3-2 Front Panel View from a Noncommand Switch

Figure 3-3 Front Panel View from a Command Switch
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Front Panel View
Cluster Tree
The cluster tree appears in the left frame of the Front Panel view and shows the name of the cluster and 
a list of its member switches (Figure 3-3). The sequence of the cluster-tree icons (Figure 3-4) mirror the 
sequence of the front-panel images. 

If you want to configure switch- or cluster-level settings on one or more switches, select the appropriate 
front-panel images. To select a front-panel image, either click the cluster-tree icon or click the 
corresponding front-panel image. The front-panel image is then highlighted. To select multiple 
front-panel images, press the Ctrl key, and click the cluster-tree icons or the front-panel images.

If the cluster has many switches, you might need to scroll down the window to display the rest of 
front-panel images. Instead of scrolling, you can also click an icon in the cluster tree to select the 
corresponding front-panel image and display it.

Figure 3-4 Cluster-Tree Icons

Note Long-Reach Ethernet (LRE) is the technology used in the Catalyst 2900 LRE XL switches. Refer to 
the Catalyst 2900 XL and Catalyst 3500 XL documentation set about these switches and the LRE 
technology.

The cluster tree also displays the status of the member switches (Table 3-1). For example, a yellow 
switch icon in the cluster tree means that particular switch is overheating or that the fan is broken. 

Complete descriptions of the icons and icon colors are available by selecting Help > Legend.

Table 3-1 Cluster Tree Icon Colors

Color Device Status

Green Switch is operating normally.

Yellow A system fault exists, such as the internal fan is not operating.

Red Switch is not powered up, has lost power, or the command 
switch is unable to communicate with the member switch.
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Front Panel View
Front-Panel Images
Use the front-panel images for visual switch management from a remote station. The LEDs on these 
images are updated at user-configurable polling intervals, making them as useful as the LEDs on the 
actual switches themselves. To change the polling intervals, select CMS > Preferences.

Figure 3-5 shows the port icons as they appear in the front-panel images.

Figure 3-5 Port Icons

The following sections provide complete descriptions of the Catalyst 3550 LED images. Similar 
descriptions of these LEDs are provided in the Catalyst 3550 Multilayer Switch Hardware Installation 
Guide.

System LED

The system LED shows whether the system is receiving power and functioning properly. Table 3-2 lists 
the LED colors and their meanings.

Table 3-2 System LED

Color System Status

Cyan (off) System is not powered up.

Green System is operating normally.

Amber System is receiving power but is not functioning properly.
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Front Panel View
Redundant Power System LED

The Redundant Power System (RPS) LED shows the RPS status. Table 3-3 lists the LED colors and their 
meanings.

Note Table 3-3 describes the RPS LED colors on the Catalyst 3550 switches. These switches use the Cisco 
RPS 300 (model PWR300-AC-RPS-N1). Other Catalyst switches use the Cisco RPS 600 
(model PWR600-AC-RPS). Refer to the appropriate switch documentation for RPS descriptions 
specific for the switch. 

Table 3-3 RPS LED

Color RPS Status

Black (off) RPS is off or is not installed.

Green RPS is connected and operational.

Blinking green RPS is backing up another switch in the stack.

Amber RPS is connected but not functioning. These conditions could exist:

• The RPS could be in standby mode. To put the RPS in Active mode, press the 
Standby/Active button on the RPS, and the LED should turn green. If it does not, 
one of these other two conditions could exist.

• One of the RPS power supplies could be down. Contact Cisco Systems.

• The RPS fan could have failed. Contact Cisco Systems.

Blinking amber Internal power supply of the switch is down, and redundancy is lost. The switch is a 
operating on the RPS. 
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Front Panel View
Port Modes and LEDs

The port modes (Table 3-4) determine the type of information displayed through the port LEDs. When 
you change port modes, the meaning of the port LED colors also changes.

Note The bandwidth utilization mode (UTL LED) is not displayed on the front-panel images. Select 
Reports > Bandwidth Graphs to display the total bandwidth in use by the switch. Refer to the 
switch hardware installation guide for information about using the UTL LED.

To select or change a mode, click the Mode button until the desired mode LED is green.

Table 3-5 describes the meaning of the port LED colors after you change the port mode.

Table 3-4 Port Modes

Mode LED Description

STAT Link status of the ports. Default mode.

DUPLX Duplex setting on the ports.

SPEED Speed setting on the ports.

Table 3-5 Port LEDs

Port Mode Port LED Color Description

STAT 
(port status)

Cyan (off) No link.

Green Link present.

Amber Link fault. Error frames can affect connectivity, and errors such as excessive 
collisions, CRC errors, and alignment and jabber errors are monitored for a link-fault 
indication.

Port is not forwarding. Port was disabled by management, by an address violation, 
or was blocked by Spanning Tree Protocol (STP).

Note After a port is reconfigured, the port LED can remain amber for up to 30 
seconds as STP checks the switch for possible loops.

Brown No link and port is administratively shut down.

DUPLX 
(port duplex mode)

Cyan (off) Port is operating in half-duplex mode.

Green Port is operating in full-duplex mode.

SPEED
(port speed)

Cyan (off) Port is operating at 10 Mbps or no link.

Green Port is operating at 100 Mbps (10/100 ports), 155 Mbps (ATM ports), or 1000 Mbps 
(fixed Gigabit port).

Blinking green Port is operating at 1000 Mbps (10/100/1000 ports).
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Topology View
Topology View
The Topology view is the tool through which connected switch clusters, cluster candidates, and 
neighboring edge devices are displayed. Also displayed is link information between the devices in the 
topology. From the topology, you can:

• Double-click a cluster icon (double-switch icon) to display cluster members.

• Add and remove cluster members.

The Topology view provides two levels of detail of the network topology:

• In the cluster view (Figure 3-6), a specific switch cluster is shown in detail, where switches and 
cluster-capable devices connected to the command switch display as cluster members or candidates.

• In the neighbors view (Figure 3-7), clusters are collapsed and represented as double-switch icons 
with links to candidate switches, other switch clusters, and edge devices.

You can toggle between the cluster and neighbors view by selecting View > Toggle Topology 
Neighbors.
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Topology View
Figure 3-6 Topology View of a Cluster

Figure 3-7 Topology View of Neighboring Devices
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Topology View
Topology Icons
The Topology view uses the same set of device icons (Figure 3-8) used in the Front Panel view cluster 
tree. It also uses an unknown device icon and a set of link icons (Figure 3-9) to show the link type and 
status between two devices.

Figure 3-8 Topology-View Device Icons

Figure 3-9 Topology-View Link Icons
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Topology View
The Topology view also displays the status of the devices and links (Table 3-6 and Table 3-7). For 
example, a red link icon means that the connection is blocked. 

Device Labels
The Topology view displays device information by using device labels, which can be the cluster and 
switch names or the switch MAC addresses and the link type between the devices. You can toggle the 
label display by selecting View > Toggle Topology Labels. The color of a device label shows the cluster 
membership of the device (Table 3-8).

Table 3-6 Device Icon Colors

Icon Color Color Meaning

Green Device is up.

Yellow Fault indication.

Red Device is down.

Table 3-7 Link Icon Colors

Link Color Color Meaning

Green Active link

Red Blocked link

Table 3-8 Device Label Colors

Label Color Color Meaning

Green A cluster member, either a member switch or the command switch.

Cyan A candidate switch that is qualified to become a cluster member.

Gray A standby command switch.

Yellow An unknown edge device that cannot become a cluster member.
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Menus and Toolbar
Menus and Toolbar
The configuration and monitoring options for configuring switches and switch clusters are available 
from the menu bar, toolbar, and the Front-Panel and Topology view pop-up menus.

Menu Bar
The menu bar provides the complete list of options for managing a single switch and switch cluster. The 
menu bar is the same whether the Front-Panel or Topology view is displayed or not.

However, options displayed from the menu bar can vary:

• When you launch CMS from a command switch, the menu bar provides options for all features 
supported by the cluster members. For example, features such as CGMP, LRE profile configuration, 
port security, and Switch Port Analyzer (SPAN) appear in the menu bar only if the cluster has the 
non-Catalyst 3550 switches that support these features. If the cluster has only Catalyst 3550 
switches, these features would not appear. (Refer to the release notes for the Catalyst switches that 
can be part of a switch cluster with the Catalyst 3550 switches.)

If you launched CMS from a specific switch, the menu bar displays the features supported only by 
that switch.

Note Table 3-9 describes the menu bar options from a Catalyst 3550 command switch and when the cluster 
only contains Catalyst 3550 member switches. Options available only from a Catalyst 3550 member 
or standalone switch are specifically identified. Options that support guide mode and wizards are also 
specifically identified.

• Cluster management options are available only from a CMS session launched from a command 
switch. However, the option for enabling a command switch is only available from a CMS session 
launched from a command-capable switch.
3-13
Catalyst 3550 Multilayer Switch Software Configuration Guide

78-11194-01



 

Chapter 3 Getting Started with CMS
Menus and Toolbar
Table 3-9 Menu Bar

Menu Bar Options Task

CMS

Page Setup Set default document printer properties to be used when printing from CMS.

Print Preview View the way the CMS window or help file appears when printed.

Print Print a CMS window or help file.

Guide Mode/Expert Mode Select which interaction mode to use when you select a configuration option.

Preferences Set CMS display properties, such as polling intervals, the default views to open at startup, 
and the color of administratively shutdown ports.

Administration

IP Addresses Configure IP information for a switch.

SNMP Enable and disable Simple Network Management Protocol (SNMP), enter community 
strings, and configure end stations as trap managers.

System Time Configure the system time or configure the Network Time Protocol (NTP).

HTTP Port Configure the HTTP port.

Console Baud Rate Change the baud rate for the switch console port.

MAC Addresses Enter dynamic, secure, and static addresses into a switch address table. You can also 
define the forwarding behavior of static addresses.

ARP Display the device Address Resolution Protocol (ARP) table, and configure the ARP 
cache timeout setting.

Save Configuration Save the configuration for the cluster or a switch.

Software Upgrade Upgrade the software for the cluster or a switch.

System Reload Reboot the software on a switch.

Cluster

Create Cluster
(from a Device Manager session 
on a command-capable switch 
that does not yet belong to a 
cluster)

Designate a command switch, and name a cluster.

Delete Cluster Delete a cluster.

Add to Cluster Add a candidate to a cluster.

Remove from Cluster Remove a member from a cluster.

Standby Commanders Create an Hot Standby Router Protocol (HSRP) standby group to provide 
command-switch redundancy.

Hop Count Enter the number of hops away that a command switch looks for members.
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Device

Launch Device Manager Launch Device Manager for a specific switch.

Host Name Change the host name of a switch.

STP Display and configure STP parameters for a switch.

IGMP Snooping Enable and disable Internet Group Management Protocol (IGMP) snooping and IGMP 
Immediate-Leave processing on the switch. Join or leave multicast groups and configure 
multicast routers.

ACL
(guide mode available)

Create and maintain access control lists (ACLs), and attach ACLs to specific ports.

QoS Display submenu options to enable and disable quality of service (QoS) and to configure 
or modify these parameters:

• Trust settings

• Queue configuration on ports

• QoS maps

• QoS classes (guide mode available)

• QoS aggregate policers (guide mode available)

• QoS policies (guide mode available)

• QoS statistics

QoS Wizard Optimize a selected device for transmitting video traffic.

IP Routing
(guide mode available)

Display submenu options to configure or modify these parameters:

• IP routing protocols

• Static routing

• Equal- and unequal-cost routing

IP Multicast Wizard Provide minimum information to configure IP multicast routing on a device so that it can 
forward multicast packets as a part of a multicast tree.

IP Multicast Routing Enable and configure multicast routing.

Router Redundancy
(guide mode available)

Add a switch to or remove a switch from an HSRP group.

Fallback Bridging Create a fallback bridging group, modify a group, delete a group, or view its details.

Table 3-9 Menu Bar (continued)

Menu Bar Options Task
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Port

Port Settings Display and configure port parameters on a switch.

Port Search Search for a port through its description.

EtherChannels Group ports into logical units for high-speed links between switches.

Protected Port Configure a port to prevent it from receiving bridged traffic from another port on the 
same switch.

Flooding Control Block the normal flooding of unicast and multicast packets, and enable the switch to 
block packet storms.

VLAN

VLAN Display VLAN membership, assign ports to VLANs, and configure Inter-Switch Link 
(ISL) and 802.1Q trunks. Display and configure the VLAN Trunk Protocol (VTP) for 
interswitch VLAN membership.

VMPS Configure the VLAN Membership Policy Server (VMPS).

VLAN Maps Create a VLAN map, and attach it to a VLAN.

Reports

Inventory Display the device type, software version, IP address, and other information about a 
switch.

Port Statistics Display port statistics.

Bandwidth Graphs Display graphs that plot the total bandwidth in use by the switch. 

Link Graphs Display a graph showing the bandwidth being used for the selected link.

Link Reports Display the link report for two connected devices. If one device is an unknown device or 
candidate, only the cluster member side of the link displays.

QoS Reports Display QoS reports of incoming or outgoing traffic for specific device interfaces.

QoS Graphs Display QoS graphs of incoming or outgoing traffic for specific device interfaces.

Router Reports Display reports with an excerpt from the routing table on the switch and the attributes of 
the HSRP group in which the switch participates.

Fallback Bridging Display a report of all fallback bridging groups and their attributes.

Table 3-9 Menu Bar (continued)

Menu Bar Options Task
3-16
Catalyst 3550 Multilayer Switch Software Configuration Guide

78-11194-01



 

Chapter 3 Getting Started with CMS
Menus and Toolbar
View

Note The topology and toggle options are not available from the Device Manager menu bar.

Refresh Update the views with the latest status.

Front Panel Display the Front Panel view.

Arrange Front Panel Rearrange the order in which switches appear in the Front Panel view.

Topology Display the Topology view.

Automatic Topology Layout Request CMS to rearrange the topology layout.

Save Topology Layout Save to Flash memory the presentation of the cluster icons that you arranged in the 
Topology view.

Toggle Topology Neighbors Toggle between showing a high-level topology view or a cluster-specific topology view.

Toggle Topology Labels Toggle the icon (device) labels to display switch names and IP or MAC addresses and 
connected port numbers.

Window List the open windows in your CMS session.

Help

Overview Provide an overview of the CMS interface.

What’s New Provide a description of the new CMS features.

Help For Active Window Display the help for the active open window. This is the same as clicking Help from the 
active window.

Contents List all of the available online help topics.

Legend Display the legend that describes the icons, labels, and links.

About Display the CMS version number.

Table 3-9 Menu Bar (continued)

Menu Bar Options Task
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Menus and Toolbar
Toolbar
The toolbar buttons display commonly used switch- and cluster-level configuration options and 
information windows such as legends and online help. Hover the cursor over an icon to display the 
feature. Table 3-10 describes, from left to right on the toolbar, the windows.

Note The topology and toggle options are not available from the Device Manager menu bar.

Table 3-10 Toolbar Buttons

Toolbar Option Task

Print Print a CMS window or help file.

Preferences Set CMS display properties, such as polling intervals, the views to open 
at CMS startup, and the color of administratively shutdown ports.

Save Configuration Save the configuration for the cluster or a switch.

Software Upgrade Upgrade the software for the cluster or a switch.

Port Settings Display and configure port parameters on a switch.

VLAN Display VLAN membership, assign ports to VLANs, and configure ISL 
and 802.1Q trunks.

Inventory Display the device type, software version, IP address, and other 
information about a switch.

Refresh Update the views with the latest status.

Front Panel Display the Front Panel view.

Topology Display the Topology view.

Save Topology Layout Save to Flash memory the presentation of the cluster icons that you 
arranged.

Toggle Topology Neighbors Toggle between showing a high-level topology view or a 
cluster-specific topology view.

Toggle Topology Labels Toggle the icon (device) labels to display switch names and IP or MAC 
addresses and connected port numbers.

Legend Display the legend that describes the icons, labels, and links.

Help For Active Window Display the help for the active open window. This is the same as 
clicking Help from the active window.
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Menus and Toolbar
Front Panel View Pop-Up Menus
The following pop-up menus are available in the Front Panel view.

Port Pop-Up Menu

You can display all port configuration windows from the Port menu on the menu bar, or you can display 
commonly used port configuration windows from the port pop-up menu (Table 3-11).

To display the port pop-up menu, click a specific port image, and right-click.

Device Pop-Up Menu

You can display all switch- and cluster-level configuration windows from the menu bar, or you can 
display commonly used configuration windows from the device pop-up menu (Table 3-12). 

To display the device pop-up menu, click the switch icon from the cluster tree or the front-panel image 
itself, and right-click.

Note The device pop-up menu for a command switch is different from the member switch device pop-up 
menu.

Table 3-11 Port Pop-Up Menu

Pop-Up Menu Option Task

Port Settings Display and configure port settings.

VLAN Define the VLAN mode for a port or ports and add ports to VLANs. Not 
available for the Catalyst 1900 and Catalyst 2820 switches.

Link Graphs Display a graph showing the bandwidth being used for the selected link.

Select All Ports Select all ports on the switch for global configuration.

Table 3-12 Device Pop-Up Menu

Pop-Up Menu Option Task

Delete Cluster (from a command switch) Delete a cluster.

Launch Device Manager (from a member switch) Launch Device Manager for the switch.

Remove from Cluster (from a member switch) Remove a member from a cluster.

Bandwidth Graphs Display graphs that plot the total bandwidth in use 
by the switch. 

Properties Display information about the device and port on 
either end of the link and the state of the link.
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Topology View Pop-Up Menus
The following pop-up menus are available in the Topology view.

Link Pop-Up Menu

You can display reports and graphs for a specific link displayed in the Topology view (Table 3-13). To 
display the link pop-up menu, click the link icon, and right-click.

If multiple links are configured between two devices, when you click the link icon and right-click, the 
Multilink Decomposer window appears. Click the link icon in this window, and right-click to display the 
link pop-up menu specific for that link.

Device Pop-Up Menus

You can display a device pop-up menu specific to the selected device icon in the Topology view:

• Cluster (Table 3-14)

• Command switch (Table 3-15)

• Member switch (Table 3-16)

• Candidate switch without an IP address (Table 3-17)

• Candidate switch with an IP address (Table 3-18)

• Neighboring device (Table 3-19)

To display a device pop-up menu, click an icon, and right-click.

Table 3-13 Link Pop-Up Menu

Pop-Up Menu Option Task

Link Report Display the link report for two connected devices. If one device is an unknown 
device or candidate, only the cluster member side of the link displays.

Link Graph Display a graph showing the bandwidth being used for the selected link.

Properties Display information about the device and port on either end of the link and the 
state of the link.

Table 3-14 Device Pop-Up Menu of a Cluster Icon

Pop-Up Menu Option Task

Expand (cluster) Toggle between showing a high-level topology view or a cluster-specific 
topology view.

Properties Display information about the device and port on either end of the link and 
the state of the link.
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Table 3-15 Device Pop-Up Menu of a Command-Switch Icon

Pop-Up Menu Option Task

Collapse (cluster) Toggle between showing high-level or a cluster-specific topology views.

Host Name Change the host name of a switch.

Properties Display information about the device and port on either end of the link and 
the state of the link.

Table 3-16 Device Pop-Up Menu of a Member-Switch Icon

Pop-Up Menu Option Task

Collapse (cluster) Toggle between showing high-level or a cluster-specific topology views.

Remove from Cluster Remove a member from a cluster.

Host Name Change the host name of a switch.

Clear Fault Acknowledge that a cluster member had lost connectivity and then 
reestablished connectivity with the cluster (for example, the member 
switch temporarily lost power).

Launch Device Manager Launch Device Manager for a switch.

Properties Display information about the device and port on either end of the link and 
the state of the link.

Table 3-17 Device Pop-Up Menu of a Candidate-Switch Icon (When the Candidate Switch Does Not 

Have an IP Address)

Pop-Up Menu Option Task

Add to Cluster Add a candidate to a cluster.

Properties Display information about the device and port on either end of the link and 
the state of the link.

Table 3-18 Device Pop-Up Menu of a Candidate-Switch Icon (When the Candidate Switch Has an IP 

Address)

Pop-Up Menu Option Task

Add to Cluster Add a candidate to a cluster.

Device Manager Launch Device Manager for a switch.

Properties Display information about the device and port on either end of the link and 
the state of the link.

Table 3-19 Device Pop-Up Menu of a Neighboring-Device Icon

Pop-Up Menu Option Task

Device Web Page Access the web management interface of the device.

Disqualification Code Display the reason why the device could not join the cluster.
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Interaction Modes
You can change the interaction mode of CMS to either guide mode or expert mode. Guide mode displays 
the parameters of a feature in a step-by-step manner and provides information about the parameter. 
Expert mode displays a configuration window in which you configure the parameters for a feature.

Guide mode is not available for all features. The person icon next to these menu bar options means that 
guide mode is available on that option:

• ACLs

• QoS classes, policers, and policies

• IP routing, static routing, and equal- and unequal-cost routing

• Router redundancy

If Expert Mode is selected and you want to use guide mode, you must click Guide Mode before 
selecting an option from the menu bar, tool bar, or pop-up menu. If you change the interaction mode after 
selecting a configuration option, the mode change does not take effect until you select another 
configuration option.

Guide Mode
Guide mode is for users who want a step-by-step approach to completing a specific configuration task. 
When you click Guide Mode, and then select a menu bar option that supports guide mode, CMS displays 
a specific parameter of the feature with information about the parameter field. To configure the feature, 
you provide information based on what CMS requests in each guide-mode step until you click Finish in 
the last step. Clicking Cancel any time during guide mode closes and ends the configuration task without 
applying any changes.

Expert Mode
Expert mode is for users who prefer to display all the parameter fields of a feature in a single CMS 
window. Information about the parameter fields are provided from the Help button on the window.

Wizards
Wizards simplify the task of QoS and IP multicast configuration. Similar to guide mode, wizards provide 
a step-by-step approach to completing a specific configuration task. Unlike guide mode, a wizard does 
not prompt you to provide information for all of the feature parameters. Instead, it prompts you to 
provide minimal information and then uses the default settings of the remaining parameters to set up QoS 
or IP multicast default configurations.

Wizards for these features are available:

• QoS wizard to configure ports with QoS priorities for video traffic

• IP multicast wizard to configure IP multicast routing on a device so that it can forward multicast 
packets as a part of a multicast tree
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Online Help
CMS provides comprehensive online help to assist you in understanding and performing configuration 
and monitoring tasks from the CMS windows (Figure 3-10).

• Feature help, available from all menu bars by selecting Help > Contents, provides background 
information and concepts on the features

• Dialog-specific help, available from the Help button on the CMS windows, provides procedures for 
performing tasks

• Index of help topics

You can send us feedback about the information provided in the online help. Click Feedback to display 
a simple online form. After completing the form, click Submit to send your comments to Cisco. We 
appreciate and value your comments.

Figure 3-10 Help Contents and Index

Information about the CMS interface.

Dialog-specific help. Is available from 
the Help button on each CMS 
window.

Feature help, such as concepts.

Legend of icons and color codes.

Glossary of terms used in the online 
help.

Click Back and 
Forward to redisplay 
previously displayed 

pages. Click 
Feedback to send us 
your comments about 

the online help.

Enter the first 
letters of the topic, 
and click Find to 
search the index.
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CMS Window Components
CMS windows use consistent techniques to present configuration information. Figure 3-11 shows the 
components of a typical CMS window. The Describe button in this figure is available only from the Port 
Settings window.

Figure 3-11 CMS Window Components

Click a tab to display more 
information.

Click a row to select it. Press Shift, 
and left-click another row to select 
contiguous multiple rows. Press Ctrl, 
and left-click rows to select non-
contiguous rows.

Describe displays the basic port 
description window if only one row is 
selected; it displays the multiple 
ports description window if more 
than one row is selected.

Modify displays a secondary 
window for the selected rows.

OK saves your changes and 
closes the window.

Apply saves your changes and leaves 
the window open.

Refresh refreshes the window to display 
the latest information.

Cancel closes the window without saving 
the changes.

Help displays help for the window and the 
menu of Help topics.

Select a cluster member from the 
Host Name list to display its settings.

3550-12T

3550-12T
3508G-XL
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Host Name List
The Host Name drop-down list lists the cluster member names. To display or change the configuration 
of a specific switch in a cluster, select the switch name.

Only switches that support the selected menu option are listed in the Host Name list. For example, the 
Host Name list on the VLAN window would not display Catalyst 1900 and Catalyst 2820 switches even 
though they are part of the cluster. Switch-specific features (such as the LRE profile configuration) are 
available from the menu bar only when the appropriate switch (such as the Catalyst 2912-LRE or 
Catalyst 2924-LRE XL switch) is a member switch.

Refer to the release notes for the Catalyst switches that can be part of a switch cluster with the 
Catalyst 3550 switches.

Tabs, Lists, and Tables
Some CMS windows have tabs that present different sets of information. Tabs are arranged like folder 
headings across the top of the window. Click the tab to display its information.

Listed information can often be changed by selecting an item from a list. To change the information, 
select one or more items, and click Modify. Changing multiple items is limited to those items that apply 
to at least one of the selections.

Some CMS windows present information in a table format. You can edit the information in these tables.

Note You can resize the width of the columns to display the column headings, or you can hover your cursor 
over the heading to display a pop-up description of the column.

Buttons
These are the most common buttons that you use to change the information in a CMS window:

• OK—Save any changes made in the window and close the window. If no changes have been made, 
the window closes. If CMS detects errors in your input, the window remains open. For more 
information about error detection, see the “Error Checking” section on page 3-27.

• Apply—Save any changes made in the window and leave the window open. If no changes have been 
made, the Apply button is disabled.

• Refresh—Update the CMS window with the latest status of the device. Unsaved changes are lost.

• Cancel—Do not save any changes made in the window and close the window.

• Help—Display procedures on performing tasks from the window.

• Modify—Display the secondary window for changing information on the selected item or items. 
You usually select an item from a list or table and click Modify.
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Accessing CMS
You must know the IP address and password of the specific switch or command switch to access CMS. 
You can assign this information to the switch in these ways:

• Using the setup program, as described in the release notes.

• Manually assigning an IP address and password, as described in the “Assigning Switch Information” 
section on page 4-2 and the “Preventing Unauthorized Access to Your Switch” section on page 6-1.

Considerations for assigning this information to a command switch and cluster members are 
described in the “IP Addresses” section on page 5-13 and “Passwords” section on page 5-14.

Accessing CMS also requires meeting the software requirements, including browser and Java plug-in 
configurations, described in the release notes.

Note Copies of the CMS pages you display are saved in your browser memory cache until you exit the 
browser session. A password is not required to redisplay these pages, including the Cisco Systems 
Access page. You can access the CLI by clicking Monitor the router - HTML access to the 
command line interface from a cached copy of the Cisco Systems Access page. To prevent 
unauthorized access to CMS and the CLI, exit your browser to end the browser session.

This procedure assumes you have met the software requirements (including browser and Java plug-in 
configurations) and have assigned IP information and a password to the switch or command switch, as 
described in the release notes.

To access CMS, follow these steps:

Step 1 Enter the switch IP address in the browser Location field (Netscape Communicator) or Address field 
(Microsoft Internet Explorer).

Step 2 Enter the switch password when prompted.

Step 3 Click Web Console.

If you access CMS from a standalone or cluster member switch, Device Manager appears. If you access 
CMS from a command switch, you can display the Front Panel and Topology views.

For information about managing passwords in switch clusters, see the “Passwords” section on page 5-14.

HTTP Access to CMS
CMS is accessed through Hypertext Transfer Protocol (HTTP), which allows switch management from 
a standard web browser. The default HTTP port is 80. If you change the HTTP port, you must include 
the new port number when you enter the IP address in the browser Location or Address field (for 
example, http://10.1.126.45:184 where 184 is the new HTTP port number).
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Verifying Your Changes
CMS provides notification cues to help you track and confirm the changes you make.

Change Notification
A green border around a field means that you made an unsaved change to the field. Previous information 
in that field is displayed in the window status bar. When you save the changes or if you cancel the change, 
the green border disappears.

Note Change notification is not available in lists and tables.

Error Checking
A red border around a field means that you entered invalid data in the field. An error message also 
displays in the window status bar. When you enter valid data in the field, a green border replaces the red 
border until you either save or cancel the change.

If there is an error in communicating with the switch or if you make an error while performing an action, 
a pop-up dialog notifies you about the error.

Saving Your Changes
The front-panel images and CMS windows always display the running configuration of the switch. 
When you make a configuration change to a switch or switch cluster, the change becomes part of the 
running configuration. The change does not automatically become part of the config.txt file in Flash 
memory, which is the startup configuration used each time the switch restarts. If you do not save your 
changes to Flash memory, they are lost when the switch restarts.

To save all configuration changes to Flash memory, you must select Administration > Save 
Configuration.

Note Catalyst 1900 and Catalyst 2820 switches automatically save configuration changes to Flash memory 
as they occur.

Tips As you make cluster configuration changes (except for changes to the Topology view and in the 
Preferences window), make sure you periodically save the configuration. The configuration is saved 
on the command and member switches.
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Using Different Versions of Web-Based Switch Management 
Software

Cluster command switches can manage a mix of Catalyst switches. However, certain models of the 
Catalyst desktop switches support different versions of web-based management software; thus, the 
interfaces can differ.

Also keep in mind that when you select a front-panel image or switch icon and then select Device > 
Device Manager from the menu bar, a new CMS session is launched, and the CMS version for that 
switch is displayed.

• The Catalyst 1900 and Catalyst 2820 switches use an older version of Switch Manager. Cluster 
management options are not available on these switches.

• The Catalyst 2950, Catalyst 3500 XL, and Catalyst 2900 XL switches use a CMS version specific 
to those switches. CMS on these switches includes Visual Switch Manager (VSM), Cluster Manager, 
Cluster Builder, and Cluster View.

• The Catalyst 3550 switches use a CMS version specific to those switches. This CMS version 
provides enhancements not available from the CMS versions on other switches. The Front Panel 
view, Topology view, and Device Manager might appear similar but are not the same as VSM, 
Cluster Manager, Cluster Builder, and Cluster View.

Refer to the appropriate switch documentation for descriptions of the web-based management software 
used on other Catalyst desktop switches, such as the Catalyst 2950, Catalyst 3500 XL, 
Catalyst 2900 XL, Catalyst 1900, and Catalyst 2820 switches.

Refer to the release notes for the list of Catalyst desktop switches that are cluster-compatible and their 
software versions.

Where to Go Next
The rest of this guide provides descriptions of the software features and general switch administration.

Refer to the online help for CMS procedures and window descriptions. Refer to the release notes for 
hardware and software requirements, including required browser versions, and for procedures for 
installing the required browser plug-in, configuring your browser, and accessing CMS.
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